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SUMMARY:  28 
We describe a method for preparation of the single freshly isolated detrusor smooth muscle cells 29 
from human urinary bladder specimens employing a two-step enzymatic procedure. The 30 
obtained viable DSM cells can be studied by various single cell techniques including the described 31 
amphotericin-B patch-clamp electrophysiology to reveal physiological and pharmacological 32 
properties. 33 
 34 
ABSTRACT:  35 
Detrusor smooth muscle (DSM) cells present within the urinary bladder wall ultimately facilitate 36 
urine storage and voiding. Preparation of the viable, fresh, and isolated DSM cells presents an 37 
important technical challenge whose achievement provides optimal cells for subsequent 38 
functional and molecular studies. The method developed and elaborated herein, successfully 39 
used by our group for over a decade, describes dissection of human urinary bladder specimens 40 
obtained from open bladder surgeries followed by an enzymatic two-step treatment of DSM 41 
pieces and mechanical trituration to obtain freshly isolated DSM cells. The initial step involves 42 
dissection to separate the DSM layer (also known as muscularis propria) from mucosa 43 
(urothelium, lamina propria, and muscularis mucosa) and the adjacent connective, vascular, and 44 
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adipose tissues present. The DSM is then cut into pieces (2-3 mm x 4-6 mm) in nominal Ca2+-45 
containing dissection/digestion solution (DS). DSM pieces are next transferred to and 46 
sequentially treated separately with DS containing papain and collagenase at ~37 °C for 30-45 47 
min per step. Following washes with DS containing enzyme-free bovine serum and trituration 48 
with a fire-polished pipette, the pieces release single DSM cells. Freshly isolated DSM cells are 49 
ideally suited for patch-clamp electrophysiological and pharmacological characterizations of ion 50 
channels. Specifically, we show that the TRPM4 channel blocker 9-phenanthrol reduces voltage-51 
step evoked cation currents recorded with the amphotericin-B perforated patch-clamp approach. 52 
DSM cells can also be studied by other techniques such as single cell RT-PCR, microarray analysis, 53 
immunocytochemistry, in situ proximity ligation assay, and Ca2+ imaging. The main advantage of 54 
utilizing single DSM cells is that the observations made relate directly to single cell characteristics 55 
revealed. Studies of freshly isolated human DSM cells have provided important insights 56 
characterizing the properties of various ion channels including cation-permeable in the urinary 57 
bladder and will continue as a gold standard in elucidating DSM cellular properties and regulatory 58 
mechanisms.  59 
 60 
INTRODUCTION:  61 
Detrusor smooth muscle (DSM) cells constitute the most abundant cell type in the urinary 62 
bladder and ultimately control urine storage and voiding through relaxation and contraction, 63 
respectively. DSM cells form smooth muscle bundles that intertwine with adjacent connective 64 
tissue, nerve processes, interstitial cells, and other cell types1. The current understanding of the 65 
role of DSM cells in urinary bladder function has been achieved through a multi-level integrated 66 
approach. Each experimental method — whether based on isolated single cells in vitro, tissue 67 
strips containing smooth muscle bundles in vitro/ex vivo, or in vivo determinations (such as 68 
cytometry and voiding function assessments) — provides important and specific insights into 69 
physiological and pharmacological properties of DSM (please see reviews1-6 for details). However, 70 
interpretation of results obtained from isolated single cells allows conclusions to be specifically 71 
attributed to the single cell type itself. This realization has been the driving force for establishing 72 
a reliable and reproducible method for obtaining freshly isolated DSM cells from the whole 73 
thickness urinary bladder specimens. Unlike many other cell types, smooth muscle cells cannot 74 
be reliably cultured due to the loss of their native phenotype including specific changes in their 75 
electrophysiological and contractile properties7,8. This fact further reinforces the importance of 76 
studies carried out on physiologically active freshly isolated DSM cells.  77 
 78 
In the late 1980’s and early 1990’s, Isenberg’s group (Germany) published a series of 79 
electrophysiological studies on freshly isolated DSM cells obtained from guinea pig urinary 80 
bladders9-13 (Table 1). The method highlighted two important observations that aided in 81 
obtaining vital cells and served as an initial guideline for others to follow. They were 1) pre-82 
treating isolated DSM pieces with Ca2+-free solution/medium prior to enzymatic treatment and 83 
2) tissue digestion with a solution containing collagenase. These two critical steps have been 84 
incorporated into all the subsequent variants of DSM cell dissociation procedures (Table 1). 85 
Currently, our group employs a two-step sequential papain-collagenase dissociation approach. 86 
DSM pieces are first treated with an enzyme solution containing papain and then with 87 
collagenase type II solubilized in the same solution (DS, dissection/digestion solution). This 88 
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approach yields single DSM cells from various species including guinea pig, pig, rat, mouse, and 89 
importantly human (Table 1).  90 
 91 
Single DSM cells provide a source for multiple molecular biology and physiological experiments. 92 
So far, protein and mRNA expressions studied with immunocytochemistry, or RT-PCR/qRT-PCR 93 
determinations revealed high levels of detection for various ion channels including the large 94 
conductance voltage- and Ca2+-activated (BK), small conductance Ca2+-activated K+ type 3 (SK3), 95 
voltage-gated K+ (Kv) , L-type voltage-gated Ca2+ (Cav), and transient receptor potential melastatin 96 
type 4 (TRPM4) channels, as well as a Na/Ca2+ exchanger14-22. They are all thought to control DSM 97 
excitability, intracellular Ca2+ levels and contractility. Patch-clamp electrophysiological 98 
approaches, performed directly on guinea pig, mouse, rat, or human DSM cells, provided direct 99 
demonstration of biophysical and pharmacological properties of L-type Cav, Kv (Kv2.x. Kv7), SK, 100 
BK, and TRPM4 channels17,19-31. The approaches included a conventional whole-cell voltage-101 
clamp, a perforated voltage-clamp, and single-channel recordings (cell attached, inside-out and 102 
outside-out configurations). Additionally, membrane potential recording of DSM using a current-103 
clamp provided evidence that target-engaging pharmacological agents alter the cell excitability. 104 
For example, the TRPM4 inhibitor 9-phenanthrol induced hyperpolarization in DSM cells 105 
obtained from humans, guinea pig, and rat urinary bladders19,20,22,31. Among the various 106 
electrophysiological methods, the amphotericin-B (and nystatin, gramicidin, and β-escin) 107 
perforated patch-clamp recordings provide a key advantage by preserving intrinsic intracellular 108 
signaling molecules and pathways. Only low molecular weight cations and to a lesser extent, Cl- 109 
— but not proteins or signaling molecules including Ca2+ — are permeable through the plasma 110 
membrane pores formed by amphotericin-B or nystatin32. The successful outcome of perforated 111 
patch-clamp experiments depends on several general variables unique to this technique. Here, 112 
we describe the details of the procedure utilizing amphotericin-B that our group has used 113 
successfully over the years15,22,33-39.  114 
 115 
Arguably, non-selective cation channels remain one of the least understood channel types in DSM 116 
cells. The first report of a non-selective cation-like channel dates back to 1993. The paper by 117 
Wellner and Isenberg11 described a 33 pS stretch-activated single channel displaying the 118 
following rank order of ion permeability: K+>Na+>Cs+>>>Ba2+>Ca2+, and inhibition of channel 119 
activity by Gd3+, a general inhibitor of non-selective cation channels. Almost a decade later, 120 
Thorneloe and Nelson40 described Na+ permeable cation currents in mouse DSM cells, inhibited 121 
by Gd3+, using whole-cell recordings. Since molecular identities of non-selective cation channels 122 
and their biophysical characterizations remain to be determined, future investigations in this 123 
research area are warranted. The protocol described herein for the recording of non-selective 124 
cation channel currents — using extracellular and pipette intracellular solutions containing Cs+, 125 
TEA+, and nifedipine (Table 2) that physiologically and pharmacologically mitigate Kv and Cav 126 
currents — has been and will continue to be useful in electrophysiological investigations of non-127 
selective cation channels. We have utilized this specific protocol to determine the extent of 128 
inhibition of whole-cell cation currents by the TRPM4 channel blocker 9-phenanthrol in guinea 129 
pig, rat and human DSM cells19,20,22.  130 
 131 
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Taken together, the method described here for obtaining freshly isolated single DSM cells from 132 
human urinary bladder provides viable cells highly suitable for electrophysiological investigations 133 
using various configurations of the patch-clamp technique, Ca2+-imaging, immunocytochemistry, 134 
in situ proximal litigation assay, and single cell RT-PCR/qRT-PCR as well as advanced molecular 135 
biology techniques including microarray analysis, RNA-seq, and CHIP-seq. The use of the 136 
amphotericin-B perforated patch-clamp method preserves the native cell environment unlike 137 
other configurations. When carried out using the specific conditions outlined here, designed to 138 
negate contributions of K+ and Ca2+ currents in DSM cells, voltage-step induced currents display 139 
the properties of non-selective cation currents suitable for biophysical and pharmacological 140 
characterizations.  141 
 142 
PROTOCOL:  143 
 144 
All methods described here have been approved by Institutional Review Board Committees of 145 
the University of Tennessee Health Science Center (Memphis, TN, IRB# 17-05714-XP), and the 146 
Medical University of South Carolina (Charleston, SC, IRB# 00045232). The approved procedures 147 
allow whole thickness urinary bladder specimens (>1 cm by >1 cm) — containing all layers 148 
including mucosa, detrusor smooth muscle, and serosa as well are attached blood vessels and 149 
adipose tissue) — to be collected from patients-donors undergoing surgical partial extraction of 150 
bladder. Patient-donors are adult (age range studied until now: 25 to 87 years old), either male 151 
or female, with or without symptoms of overactive bladder (as classified by American Urological 152 
Association I-PSS score41). Surgical procedures involve a variety of medical conditions including 153 
radical cystectomy for urothelial carcinoma, and adenocarcinoma. In such cases, the collected 154 
urinary bladder specimen is remote from the site of tumor.  155 
 156 
1 Dissection of DSM tissues and preparation of mucosa-free DSM pieces 157 
 158 
1.1 Examine the whole thickness urinary bladder specimen that arrived in the lab from the 159 
operating room in a tightly sealed container filled with the cold dissection/digestion solution 160 
(Figure 1 and Table 2 for composition of DS). 161 
 162 
NOTE: The specimen is usually kept in cold DS from a few hours to overnight prior to arrival in 163 
the laboratory. For longer storage, DS (Table 2) is supplemented with 1 mM CaCl2.  164 
 165 
1.2 Remove and rinse the human whole thickness DSM specimen (containing all layers 166 
including mucosa, DSM, and serosa) with ice-cold DS to wash out attached debris and blood.  167 
 168 
1.3 Pin the urinary bladder specimen, mucosa facing upward and serosa down, onto a silicone 169 
enantiomer-coated (Table of Materials, Table of Materials) 150 mm diameter round dish filled 170 
with ice-cold DS (Figure 1B).  171 
 172 
1.4 Remove the adjacent adipose tissue, blood vessels, epithelium (urothelium) and 173 
muscularis mucosa from the specimen by sharp dissection using microscissors and forceps. 174 
 175 
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1.5 Cut out several mucosa-free DSM pieces (~2-3 mm long and 4-6 mm wide) (Figure 1C). 176 
 177 
2 Enzymatic dissociation of DSM pieces yielding freshly isolated single DSM cells 178 
 179 
2.1 Place 3 to 6 DSM pieces into a tube containing 1 to 2 mL of pre-warmed (~37 °C) DS 180 
containing papain and dithiothreitol (DS-P, Table 2) and incubate DSM pieces in DS-P for 30-45 181 
min at ~37 °C gently shaking the tube occasionally (once every 10-15 min).  182 
 183 
NOTE: To optimally control the temperature for enzymatic treatment, tubes with tissue pieces 184 
and enzyme solutions are placed in either a glass tissue chamber filled with water connected to 185 
a circulating heated water bath (Figure 1D) or a high-precision temperature-controlled shaking 186 
water bath (Figure 1E).  187 
 188 
2.2. Remove DS-P from the tube, briefly wash DSM pieces with ice cold DS, discard cold DS 189 
from the tube leaving DSM pieces sitting at the bottom of the tube. 190 
 191 
2.3 Add 1 to 2 mL of DS-containing collagenase type II (DS-C, Table 2) to the tube with DSM 192 
pieces, gently mix; and incubate for 25-40 min at ~37 °C gently shaking the tube occasionally 193 
(every 10-15 min). 194 
 195 
2.4 Discard DS-C and wash enzyme-treated DSM pieces 5-10 times with ice-cold DS. 196 
 197 
2.5 Following the last wash, leave DS solution inside the tube; gently triturate with a fire-198 
polished Pasteur pipette several times to release single DSM cells.  199 
 200 
2.6 Place a few drops of DS solution containing dispersed DSM cells onto a glass-bottom 201 
chamber or a coverslip and visually inspect for the quality under a microscope (using a 20x or 40x 202 
objective) after at least 5 min following the application to allow the cells to adhere to the bottom. 203 
 204 
2.7 Immediately use freshly isolated DSM cells for electrophysiological experiments or store 205 
the cells in a tube containing DS at ~4 °C either on ice or in a refrigerator until use (typically for 206 
up to 8 h of preparation).  207 
 208 
NOTE: Within the same preparation the quality of cells varies from highly viable to over-digested, 209 
dead DSM cells (Figure 2). When the sequential papain-collagenase method yields a very high 210 
number of unviable cells, the preparation is discarded, and a new digestion of DSM pieces is 211 
carried out but with reduced incubation intervals. If the procedure results in too few DSM cells 212 
then for the subsequent digestion of DSM pieces, the incubation intervals are increased. Positive 213 
immunoreactivity to α-smooth muscle actin confirms the identity of DSM cells (Figure 3).  214 
 215 
3. Recording voltage-step induced cation currents from DSM cells using amphotericin-B 216 
perforated whole-cell voltage patch-clamp technique 217 
 218 
3.1  Pipette 0.25-1 mL of cell suspension onto a glass bottom chamber sitting on a stage of an 219 
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inverted microscope and allow the cells to adhere to the glass bottom. 220 
 221 
3.2  After incubation for at least 45 min, remove DS from the bath and replace with the E 222 
solution (Table 2) by superfusion where the solution flow aided by gravity via inlet tubing slowing 223 
replaces DS with the new solution while outlet tubing connected to a vacuum waste vessel 224 
removes the chamber solution and prevents overflow. Note that E solution contains 225 
tetraethylammonium (TEA+) and cesium (Cs+) ions to inhibit K+ currents.  226 
 227 
3.3  Prepare a working stock solution of amphotericin-B in dimethyl sulfoxide (DMSO) (1 mg 228 
per 10 µL of DMSO). To fully dissolve amphotericin powder, sonicate (at least 15 min) and vortex 229 
the solution well. 230 
 231 
NOTE: This step usually takes less than 10 min. Dissolving 3-4 mg of amphotericin-B in 30-40 µL 232 
of DSMO in a 1.5 mL microcentrifuge tube works well. Higher quantities of amphotericin-B 233 
require more DSMO solvent typically resulting in a longer interval for mixing and incomplete 234 
solubilization of the amphotericin-B solid particles present in the tube.  235 
 236 
3.4  Dissolve stock solution of amphotericin-B in the pipette solution (solution P, Table 2) to 237 
obtain a final concentration of 200-500 µg/mL. This step requires extensive sonication and 238 
vortexing at a high-speed setting (8-10/10) for ~30 to 60 min per step to ensure optimal mixing 239 
and prevention of amphotericin-B precipitate formation in the pipette solution. 240 
 241 
NOTE: Amphotericin-B will precipitate over-time and is light-sensitive. The working pipette 242 
solution containing Amphotericin-B is checked for solubility, hand-mixed prior to pipette filling, 243 
and kept in the dark. 244 
  245 
3.5  Pull multiple patch electrodes, fire-polish electrode tips, and (if needed) coat the tips with 246 
dental wax.  247 
 248 
3.6  Fill the tip of a patch electrode with the pipette solution (solution P, Table 2) without 249 
amphotericin-B by briefly dipping the electrode in the solution. 250 
 251 
3.7  Backfill the electrode with the same pipette solution containing amphotericin-B. 252 
 253 
3.8  Mount the electrode onto a holder connected to a patch-clamp amplifier headstage. 254 
 255 
3.9  Using a micromanipulator, place the electrode just below the surface of the extracellular 256 
solution so that the tip of the electrode is just submerged.  257 
 258 
3.10  In the voltage-clamp mode, set the holding potential to 0 mV and adjust the current to 0 259 
pA with the pipette offset dial on the commercial amplifier (Table of Materials). 260 
 261 
3.11  Determine the electrode resistance using the Membrane Test window/function of the 262 
commercial acquisition software (Table of Materials). To activate click Tools>Membrane 263 
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Test>Play or a shortcut icon in the software. The determined electrode resistance should be in 264 
the range of 2 to 5 MΩ.  265 
 266 
NOTE: Membrane Test function provided in the commercial acquisition software or Seal Test 267 
option on the amplifier can be used to monitor electrode resistance by applying voltage steps 268 
repetitively.  269 
 270 
3.12  Continue monitoring electrode resistance while advancing the electrode toward a chosen 271 
DSM cell with a micromanipulator (Figure 4A).  272 
 273 
NOTE: To be considered a viable DSM cell, the cell must show spindle-shaped elongated 274 
morphology, a well-defined halo around the cell, crisp edges, and semi-contractile (serpentine) 275 
appearance.  276 
 277 
3.13  When touching the cell surface with the electrode — indicated by a rapid increase in the 278 
electrode resistance measured with the Membrane Test function — form a giga-seal by applying 279 
gentle rapid negative pressure to the electrode holder via tubing. This results in negative pressure 280 
created at the tip of the electrode that pulls cell membrane into electrode aiding in the formation 281 
of a giga-seal or a very tight contact between the electrode and plasma membrane (Figure 4B).  282 
 283 
3.14  Once the giga-seal forms, compensate pipette capacitance by adjusting fast and slow dials 284 
on the commercial amplifier and monitor giga-seal stability (leak current) using the Membrane 285 
Test function.  286 
 287 
3.15  Allow time, typically 30-60 min, for amphotericin-B to diffuse down the pipette and be 288 
inserted into the plasma membrane forming pores primarily selective to monovalent cations. 289 
During this step, continue monitoring the giga-seal with the Membrane Test function. As cell 290 
perforation increases so does the amplitude of the capacitance transients (compare Figure 4B 291 
versus Figure 4C displaying no and effective cell perforation, respectively) measured with the 292 
Membrane Test function.  293 
 294 
3.16  When the patch perforation is optimal (judged by stable series resistance typically below 295 
50 MΩ), cancel out the capacitance transients by adjusting the dials for cell capacitance and 296 
series resistance on the amplifier. Series resistance compensation can also be performed at this 297 
time (Figure 4D). 298 
 299 
3.17.  Once stable voltage-step induced cation currents evoked by the specified protocol are 300 
observed, apply a compound or physiological condition to test by superfusion and record the 301 
responses for the control-, test-condition, and washout (if possible) with the commercial 302 
acquisition software. 303 
 304 
3.17.1  Record currents with a routine voltage-step protocol that involves holding DSM cells at -305 
64 or -74 mV and stepping the voltage in 10 mV increments for 400 or 500 ms from -94 to +96 306 
mV and returning to the holding potential.  307 
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 308 
NOTE: The membrane potential values are adjusted for a liquid junction potential of 14 mV (using 309 
P and E solutions, Table 2). The liquid junction potential is obtained in the commercial acquisition 310 
software (Table of Materials) by clicking (Tools>Junction Potentials) and entering the 311 
concentrations of solution ion components. A ramp protocol can also be used to obtain current 312 
recordings. 313 
  314 
3.17.2  Run the voltage-protocol in continuous ~1 min interval during an experiment recording 315 
currents for pre-addition control, test condition, and washout.  316 
  317 
4. Data analysis and visualization 318 
 319 
4.1  Open recorded files in the commercial data analysis software (Table of Materials) for the 320 
control, test condition, and washout by clicking File>Open Data and selecting files of interest for 321 
opening. 322 
 323 
NOTE: For analysis typically three files (each containing a single set of traces to a single protocol 324 
run) for each condition are opened and analyzed. The responses are subsequently averaged to 325 
obtain a mean response for each condition. The software used for data acquisition contains an 326 
option to automatically collect user-specified multiple test runs and average them for single 327 
output file that can be used as an alternative.  328 
 329 
4.2  Obtain the average response over the last 200 ms for the current trace measured at each 330 
voltage; the duration interval chosen reflects a steady-state level of voltage-step current 331 
activation. To do so follow the steps below.  332 
 333 
4.2.1.  Select a file of interest for analysis in the commercial analysis software (Table of 334 
Materials).  335 
 336 
NOTE: The software positions the most recently imported file into its active display window. The 337 
open file displays a series of overlapping traces obtained with a voltage-step protocol. By default, 338 
within the active window four cursors (displaying x and y values for the highlighted trace) are 339 
shown.  340 
 341 
4.2.2.  Choose the range for analysis by positioning cursor 2 at the end of the 400 or 500 ms 342 
voltage step and cursor 1 at the interval of 200 ms before that so that the analysis range is 200 343 
ms.  344 
 345 
4.2.3.  Obtain responses for each voltage by clicking Analyze>Quick Graph>IV (or the IV shortcut 346 
icon) (in the prompt window before generating data confirm that for y-axis (Current) signal 347 
Region options “Cursors 1..2” and “Mean” are selected). Click OK to generate the I-V graph and 348 
to place the data into a Results column sheet that can be viewed by accessing Windows>Results.  349 
 350 
4.2.4.  Analyze additional files by repeating steps 4.2.1 – 4.2.3. Click Analyze>Quick Graph>IV or 351 
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the IV icon shortcut, select Append rather than Replace to add additional data to the Results 352 
sheet when processing the traces.  353 
 354 
4.2.6.  Copy data to a spreadsheet by selecting the columns of interest and pressing CTRL+C to 355 
copy and CTRL+V to paste. Store the Results worksheet in the commercial analysis software 356 
(Table of Materials) in (*.rlt) format by clicking File>Save As.   357 
 358 
4.3  For each cell, normalize the responses for all three conditions to the value of the 359 
maximum voltage step for the pre-addition control (according to the formula: 360 
Response/ResponseControl-Max) and graph the responses as current (or current density) values 361 
versus voltage relationships (Figure 6). 362 
 363 
4.3.1.  In a worksheet processor, determine the average responses as either currents (pA) or 364 
current densities (pA/pF) for control, test condition (in this example, 9-phenanthrol), and 365 
washout at each voltage step. 366 
 367 
4.3.2.  Divide values for each voltage of each condition (control, 9-phenanthrol, and washout) by 368 
the maximum control response obtained at the highest voltage (+96 mV in Figure 6) for the pre-369 
addition control following the formula: Normalized response for condition(x) = Response(x)/ 370 
ResponseControl-Max for (x).  371 
 372 
4.4.  For summary analysis, arrange the data in a format that can be easily copied to a 373 
graphical program (e.g. GraphPad Prism) for visualization.  374 
 375 
REPRESENTATIVE RESULTS:  376 
Enzymatic dissociation of DSM pieces provides healthy freshly isolated DSM cells routinely used 377 
in functional and molecular studies such as: patch-clamp electrophysiology and 378 
immunocytochemistry. Figure 1 summarizes the dissection steps and visualizes the setups 379 
employed for temperature control of enzymatic treatment steps. Figure 2 illustrates bright-field 380 
images of DSM cells obtained from three human urinary bladder specimens each from a different 381 
patient-donor. Healthy single DSM cells are characterized by spindle-shaped morphology, crisp 382 
well-defined edges, a well-defined halo around the cell, and semi-contractile (serpentine-like) 383 
appearance when viewed under the microscope (see DSM cells demarked by white arrows in 384 
Figure 2). They also respond to contraction stimulating agents such as the muscarinic agonist 385 
carbachol or high K+ (60 mM) applications. DSM cells show positive immunoreactivity for α-386 
smooth muscle actin confirming their identity (Figure 3).  387 
 388 
DSM cells are ideally suited for patch-clamp electrophysiological investigations of ion channel 389 
properties. Here, we describe the amphotericin-B perforated patch-clamp recording method 390 
using pipette and extracellular solutions (Table 2) to optimally record voltage-step induced cation 391 
channels. Under the specific conditions employed, blockade of Kv and L-type Ca2+ currents with 392 
Cs+/TEA+ and nifedipine, respectively, ensured the elimination of contribution of these ionic 393 
components to the whole-cell voltage-evoked currents. Figure 4 and Figure 5 show, respectively, 394 
the experimental steps of the amphotericin-B perforated patch-clamp method and 395 
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representative whole-cell currents measured either with a voltage-step induced or a ramp 396 
protocol in three different human DSM cells, each from a different patient donor. Note that the 397 
recordings display a certain degree of variability in terms of current amplitudes and outward 398 
rectification. Additional experiments revealed that 9-phenanthrol, a TRPM4 channel inhibitor, 399 
effectively and reversibly inhibited human DSM cation currents at negative and positive voltages 400 
(Figure 6). The 9-phenanthrol-sensitive current component illustrates a stronger inhibition at 401 
positive voltages and outward rectification (Figure 6C).  402 
 403 
FIGURE AND TABLE LEGENDS:  404 
 405 
Figure 1: Summary of dissection steps resulting in the preparation of detrusor smooth muscle 406 
(DSM) pieces and setup used for enzymatic dissociation. Shown are images of: (A) a whole 407 
thickness human urinary bladder specimen provided from an open bladder surgery as extraneous 408 
surgical material in ice-cold DS, (B) the same preparation after pinning with a partially dissected 409 
DSM layer, (C) DSM pieces of variable dimensions cut out from the DSM layer ready for enzymatic 410 
digestion (smaller pieces) or other experimental investigations (larger pieces), (D, E) alternative 411 
setups used for enzymatic digestion of DSM pieces consisting of either (1) a temperature-412 
controlled circulating water bath connected via tubing to a large glass tissue chamber filled with 413 
water, a rubber holder for tubes, plastic tubes containing DSM pieces and enzyme solutions 414 
prepared in dissection/digestion solution (DS, either DS-P or DS-C, Table 2) and a temperature 415 
probe linked to a display allowing for continuous monitoring (D), or (2) a large water-filled 416 
temperature-controlled bath containing a holder and tubes with DSM pieces and enzyme 417 
solutions (E).  418 
 419 
Figure 2: Representative bright-field images of human freshly isolated DSM cells obtained using 420 
the sequential papain-collagenase digestion method. (A-F) Displayed are images of viable, 421 
physiologically active DSM cells considered suitable candidates for attempting perforated patch-422 
clamp recordings. (G, H) Images of non-viable or over-digested cells; such cells were avoided for 423 
patch-clamp experiments. White and black arrows in panels (A-H) point to DSM cells considered 424 
viable and non-viable, respectively, for attempting patch-clamp recordings. Note that the black 425 
arrows in panels (A, C, and G) point to cell fragments (circular pieces) or small cells lacking DSM 426 
morphology and in (H) the cells appear pale and dilated. Images are from three different urinary 427 
bladder specimens (A and B: patient-donor source one, C and D: patient-donor source two, and 428 
E-H: patient-donor source three). 429 
 430 
Figure 3: Expressions of transient receptor potential melastatin type 4 (TRPM4) channel and α-431 
smooth muscle specific actin immunoreactivities in single human DSM cells by 432 
immunocytochemistry analysis. (A) Shown are confocal images showing immunocytochemical 433 
detection of TRPM4 channel protein expression in a human DSM cell. Red staining (bottom left) 434 
indicates TRPM4 channel proteins; blue (DAPI) staining detects cell nuclei (top left); green 435 
staining indicates α-smooth muscle actin (α-SMA, top right); the merged image (bottom right) 436 
illustrates the overlap of all three images. (B) Confocal images illustrating attenuation of 437 
immunocytochemical detection of TRPM4 channel protein expression in the presence of a 438 
TRPM4-specific competing peptide (CP) in isolated human DSM cells. Blue (DAPI) staining 439 
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indicates cell nuclei (top left); green staining is for α-smooth muscle actin (α-SMA, top right); the 440 
merged image (bottom right) illustrates the overlap of all three images. The results were verified 441 
in four separate experiments using DSM whole tissue or multiple DSM cells isolated from four 442 
patients. Images are from Hristov et al. (2016)22 and used with permission.  443 
 444 
Figure 4: Schematic illustration of steps involved in giga-seal formation and amphotericin-B 445 
perforation of human DSM cells. Illustrated are spatial positions of an amphotericin-B containing 446 
pipette and a DSM cell along with associated responses for membrane tests obtained in the 447 
commercial acquisition software (Table of Materials) by altering voltage steps (either -10 or -20 448 
mV in this example) determining resistance. Configurations are: (A) prior to the cell approach 449 
with an electrode, (B) after giga-seal formation obtained by positioning the amphotericin-B 450 
containing pipette (amphotericin-B represented by red dots) onto the cell surface and applying 451 
negative pressure, (C) the on-cell configuration shown ~45 min after giga-seal formation, at this 452 
time-point amphotericin-B has diffused down the pipette and its molecules have inserted into 453 
the plasma membrane at the tip of the electrode forming cation permeable pores, and (D) the 454 
same configuration as in (C) but with capacitance transients canceled out using dials for whole-455 
cell capacitance and series resistance on the amplifier.  456 
 457 
Figure 5: Whole-cell cation currents recorded with amphotericin-B perforated patch-clamp 458 
method in human DSM cells. (A) A diagram of the voltage-step protocol illustrates a holding 459 
potential of -74 mV and voltage-steps of 400 ms duration from -94 to +96 mV carried out in 10 460 
mV increments and then returned to -74 mV. (B, C) Representative current traces along with 461 
current density-voltage plots from two different human DSM cells, each from a different urinary 462 
bladder specimen/patient-donor obtained with the voltage-step protocol described in (A). (D) An 463 
example of a current trace obtained with a ramp protocol (graphically represented in the top 464 
inset as voltage change from -94 to +116 mV over a 1 s duration at 0.21 mV/ms, holding potential 465 
was -94 mV). On the right in panels (B-D), the graphs display the current density-voltage 466 
relationship for each DSM cell recorded.  467 
 468 
Figure 6: TRPM4 channel blocker 9-phenanthrol-mediated inhibition of voltage-step induced 469 
cation currents in human DSM cells. (A) Shown are representative currents measured with the 470 
voltage-step protocol described in Fig. 5A for control, 9-phenanthrol, and washout. (B) Summary 471 
of normalized responses versus voltage for control, 9-phenanthrol, and washout in seven DSM 472 
cells (from seven different patient-donors). (C) Difference current for 9-phenanthrol-sensitive 473 
component obtained by subtracting the values in the presence of 9-phenanthrol (30 µM) from 474 
those of the control shown in (B). Data in (B) and (C) are displayed as means with error bars for 475 
SEM, * depicts significance (p<0.05, paired Student’s test) for the comparison of control vs 9-476 
phenanthrol at each voltage. Panels (A) and (B) have been reproduced from Hristov et al. (2016)22 477 
and used with permission.  478 
  479 
Table 1: Summary of enzymatic approaches used for isolating single DSM cells from urinary 480 
bladders of various species 481 
References: Klockner & Isenberg (1985)13,42; Klockner & Isenberg (1986)43; Schneider et al. 482 
(1991)10; Bonev & Isenberg (1992)9; Weidelt & Isenberg (2000)44; Moore et al. (2004)14; Inoue & 483 
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Brading (1990)45; Inoue & Brading (1991)46; Nakayama & Brading (1995)47,48; Montgomery & Fry 484 
(1992)24; Gallegos and Fry (1994)49; Fry et al. (1994)50; Sui et al. (2001)51; Wu et al. (2002)52; Bonev 485 
& Nelson (1993)53,54; Heppner et al. (1997)26; Petkov et al. (2001)55; Shieh et al. (2001, 2007) 56,57; 486 
Petkov et al. (2001)58; Thorneloe & Nelson (2003)59; Thorneloe & Nelson (2004)40; Petkov & 487 
Nelson (2005)27; Hristov et al. (2008)60; Layne et al. (2010)61; Hristov et al. (2011)15; Xin et al. 488 
(2012)35; Parajuli et al. (2012)25; Malysz et al. (2013)29; Parajuli et al. (2013)31; Lee et al. (2013)62; 489 
Malysz et al. (2014)23; Smith et al. (2013)19,20; Hristov et al. (2016)22; Lee et al. (2017)63; Yarotskyy 490 
et al. (2018) 64 491 
  492 
Table 2: Compositions of dissection/digestion solution (DS), and pipette and extracellular 493 
solutions used in perforated patch-clamp experiments 494 
 495 
DISCUSSION:  496 
The procedures described here explain the steps involved in the preparation of viable, freshly 497 
isolated DSM cells from whole thickness human urinary bladder specimens using enzymatic 498 
digestion and in the recording of whole-cell cation currents sensitive to the TRPM4 channel 499 
inhibitor 9-phenanthrol employing the amphotericin-B perforated patch-clamp approach. The 500 
enzymatic procedure relies on a two-step sequential exposure referred to herein as the 501 
sequential papain-collagenase digestion method. DSM tissues are first treated with papain and 502 
dithiothreitol (an enzyme stabilizing agent) under a nominal Ca2+-free condition, followed in the 503 
second step by collagenase type II in the presence of low Ca2+. The rationale for carrying out 504 
papain digestion under low Ca2+ conditions in smooth muscle cells dates back to the late 1980’s. 505 
Freshly isolated carotid artery smooth muscle cells prepared with papain displayed an elongated 506 
shape, showed viability (resistance to Trypan Blue uptake) and responded to contractile stimuli 507 
(higher Ca2+ and histamine)65. Years later, this method was applied in the preparation of DSM 508 
cells (see Table 1). The choice of collagenase type II rather than other types relates to its relatively 509 
high proteolytic activity ideally suited for smooth muscle tissues including DSM. Indeed, 510 
collagenase treatment alone could yield single DSM cells albeit requiring extensive enzyme 511 
exposure (≥60 min)53,54. Since collagenase activity depends on Ca2+ and the enzyme is inactive 512 
under the Ca2+-free conditions, optimum enzymatic digestion of DSM pieces requires the 513 
presence of Ca2+ 66. In our case, DS-C contains 100-200 µM [Ca2+] (Table 2). After enzymatic 514 
treatment, digested DSM pieces are washed gently a number of times with cold DS without 515 
enzymes or Ca2+ to remove any enzyme bound to tissues. The ice-cold DS helps to preserve DSM 516 
cell integrity and to limit enzymatic activity of any remaining papain or collagenase. In the last 517 
step, trituration of enzyme-treated DSM pieces with a fire polished Pasteur pipette releases 518 
single DSM cell. DSM cells are either immediately placed onto a recording chamber for patch-519 
clamp studies or other types of experimentation or stored on ice in DS for use later on the same 520 
day (typically within 8 hrs of preparation, but the cells remain viable for up to 24 h).  521 
 522 
We identified several important considerations for successfully obtaining single DSM cells. The 523 
first pertains to the human DSM specimen source quality. To optimally preserve tissue integrity, 524 
DSM samples obtained from open bladder surgeries are placed in ice-cold DS as soon as possible 525 
and maintained in a cold environment. Specifically, upon surgical extraction from the patient, the 526 
bladder specimen is immediately placed on a fully prepared side table in the operating room. 527 
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Gross examination of the whole specimen (usually obtained during radical or simple cystectomy) 528 
and its opening follow. After visual inspection, a piece of whole thickness urinary ladder specimen 529 
is removed from a remote area of the specimen grossly uninvolved with tumor and immediately 530 
placed into a cup (either 50 or 100 mL) containing cold (~4 °C) Dissection Solution (DS) (Table 2) 531 
and then tightly closed with a lid. Due to the planned nature of the harvesting of the tissue, the 532 
operating room personnel and auxiliary staff doing the harvesting are alerted at the start of the 533 
surgical case in order to have the materials available in the operating room at the time of tissue 534 
extraction. These precautions along with the routine, repetitive nature of the processing steps 535 
keep the warm ischemia time for the tissue — from extraction to placement in the chilled 536 
container with DS solution — to less than 5 min. The container is then placed in a refrigerator or 537 
on ice in a cooler to maintain the cold environment and transported (ice-cold) to the laboratory. 538 
Once the specimen arrives in the laboratory, dissection and enzymatic dissociation steps 539 
commence. It is very difficult to predict whether a given DSM specimen will yield high quality 540 
DSM cells following enzymatic dissociation, so we proceed with the enzymatic dissociation steps. 541 
In many cases, in parallel with electrophysiological experiments, our group conducts isometric 542 
tension recordings on DSM strips prepared from the same DSM specimens. We have found that 543 
we can usually obtain high quality DSM cells from preparations that also successfully provide 544 
viable strips for isometric contraction studies (our unpublished observation).  545 
 546 
The second factor relates to different enzyme lot variabilities. We observed that for both papain 547 
and collagenase type II, each time a new lot of enzyme arrives from a supplier, the enzyme 548 
activity in DS for tissue digestion can vary. We, hence, routinely optimize the enzyme 549 
concentration and incubation intervals for each new lot. To minimize the lot variability 550 
contribution, we order larger quantities of the same lot and make a large batch of stock solutions 551 
in 2 mL aliquots of enzymes and store them at ~-20 °C until use. Over time, however, frozen 552 
stocks (stored up to 2 weeks) can lose their enzymatic activity. The third variable relates to the 553 
temperature of enzyme digestion treatments. Enzymatic activities of both papain and 554 
collagenase display temperature-dependency. Papain and collagenase type II are most active in 555 
the temperature ranges encompassing normal body physiology67,68. Therefore, we aim to 556 
maintain the enzyme treatments stable at ~37 °C avoiding higher temperatures to preserve DSM 557 
cell integrity. The fourth consideration concerns the variability of the quality of DSM cells present 558 
within each preparation ranging from highly viable (exhibiting excellent classical smooth muscle 559 
characteristics) to non-healthy, over-digested cells. A prolonged enzyme incubation interval is 560 
one of the main reasons for obtaining a high number of damaged cells. Excessive enzyme 561 
treatments also impair protein structures of ion channels, receptors, and transporters, adversely 562 
affecting their functionality. Interpretation of results obtained from enzymatically obtained, 563 
freshly isolated cells should bear this consideration in mind. Optimization of enzyme digestion 564 
conditions aims to increase the percentage of highly viable cells. Experimental approaches relying 565 
on a higher number of viable cells such as microarray analyses require more robust optimizations 566 
than those successfully carried out on fewer cells such as single-cell patch-clamp 567 
electrophysiology or Ca2+ imaging. Consideration of the aforementioned factors has guided our 568 
research efforts over the last decade in obtaining high quality single DSM cells.  569 
 570 
The perforated patch-clamp technique has been a mainstay electrophysiological approach for 571 
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over a quarter of a century. Several publications provide details of the technical considerations69-572 
73. Cell perforation can be obtained with amphotericin-B, nystatin, gramicidin, or β-escin (see 573 
reference32 for overview of each). The main advantage of perforated patch-clamp recordings 574 
over other electrophysiological approaches is that the native intracellular environment — 575 
including intracellular Ca2+ and signaling molecules (e.g., cAMP, PKA, phosphates, and 576 
phosphodiesterases) — is preserved. This technique is, hence, ideally suited for investigating 577 
whole-cell ion channel currents and their regulatory mechanisms under near physiological 578 
conditions. A key caveat is that intracellular cell composition cannot be precisely controlled 579 
unlike other electrophysiological methods such as conventional whole-cell and single-channel 580 
excised-patch (inside- and outside-out) recordings. In our experience, three factors routinely 581 
contribute to successful experimental outcomes of amphotericin-B-perforated patch-clamp 582 
experiments. The first is the quality of the DSM cell chosen to attempt a recording. When DSM 583 
cells are highly viable displaying a semi-contractile (serpentine-like), high-contrast shiny 584 
appearance with a well-defined halo around the cell surface and attach tightly to the glass 585 
bottom of the recording chamber then giga-seal formation and cell perforation occur relatively 586 
easy. The second and third factors for success, respectively, relate to quality of source and 587 
solubilization of amphotericin-B (in dimethyl sulfoxide/DMSO and intracellular pipette solution). 588 
We observed discrepancies among different suppliers in terms of source and lot variabilities. Each 589 
day we prepare a fresh solution of amphotericin-B stock solution from powder followed by its 590 
dilution in intracellular pipette solution. These steps require extensive sonication and vortexing. 591 
With freshly made amphotericin-B-containing pipette solution, successful cell perforation (<50 592 
MΩ) following giga-seal formation can be usually obtained within 30 min. The concentration of 593 
amphotericin-B in the pipette solution also requires optimization dependent on the 594 
amphotericin-B lot and source. Under our experimental conditions, the final amphotericin-B 595 
concentrations in the pipette range from 200 to 500 µg/mL. Since amphotericin-B exhibits light 596 
sensitivity, its solutions need to be kept in the dark. Using the amphotericin-B perforated patch-597 
clamp technique, our group recorded voltage-step induced K+, Ca2+, and non-selective cation 598 
currents from human, guinea pig, mouse, and/or rat DSM cells17,21-23,29-31,35,60. Here, we describe 599 
conditions for recording non-selective cation currents in human DSM cells. 9-Phenanthrol, a 600 
blocker of TRPM4 channels, attenuated voltage-step induced currents supporting the role of 601 
these channels in the control of DSM excitability. As a note, it usually requires at least 45 min 602 
after obtaining a giga-seal and initiation of perforation to record optimum stable voltage-step 603 
induced non-selective cation currents. Voltage ramps can also be used as an alternative to 604 
voltage-step protocols30,64. Here, a voltage-step protocol from a hyperpolarized holding 605 
membrane potential was preferred rather than a ramp protocol since the former approach 606 
minimizes the effect of voltage-dependent inactivation and allows for averaging of evoked 607 
current over a duration of a voltage–step where the ramp provides a single data point per 608 
voltage. The latter point especially applies to human DSM cells as the currents show variable 609 
activity during voltage steps (Figures 5-6). The amphotericin-B perforated patch-clamp technique 610 
has been essential in identifying the properties of DSM cells and other cell types and will continue 611 
to aide in providing novel discoveries in the future. Furthermore, freshly isolated single DSM cells 612 
can be successfully used for measuring whole-cell K+, Cl-, and Ca2+ currents with the conventional 613 
mode of the patch-clamp technique, membrane potential recording with the current clamp, and 614 
single channel recordings as exemplified by our prior reports23,29,35,64.  615 
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  616 
In addition to single cell patch-clamp methods, freshly isolated DSM cells can be studied with 617 
other technical approaches including Ca2+ imaging, RT-PCR/q-RT-PCR, immunocytochemistry, in 618 
situ proximity ligation assay, and genomic approaches (e.g., microarray, RNA-seq, CHIP-619 
seq)15,18,30,33,34. As single cell transcriptome determination methods continue to evolve and 620 
become highly sensitive, we envision in a future ability to routinely and specifically link electrical 621 
or pharmacological properties of individual DSM cells with their transcriptome/proteome 622 
profiles. This will be achieved by first recording from a DSM cell and then extracting mRNA or 623 
protein followed by transcriptomic/proteomic analyses. Although such methods have been 624 
tested already in non-DSM cells, they are at present technically challenging, lack sensitivity to be 625 
considered routine, and limited to successful detection of a few selected gene products74. 626 
Function-molecular profile expression linking studies when done on DSM cells obtained from 627 
urinary bladders derived from control and diseased patient-donors will provide insights into 628 
physiological processes essential for driving normal DSM functions, pathogenesis, and in 629 
identifying effective novel therapeutic approaches.  630 
 631 
ACKNOWLEDGMENTS:  632 
This work was supported by NIH-R01DK106964 grant to Georgi V. Petkov. The authors thank Dr. 633 
Viktor Yarotskyy and Ms. Sarah Maxwell for critical evaluation of the manuscript. We are also 634 
grateful to urology staff surgeons at MUSC and UTHSC: Drs. Thomas Keane, Harry Clarke, Stephen 635 
Savage, Ross Rames, Sandip Prasad, Jonathan Picard, Christopher Ledbetter, and Anthony 636 
Patterson as well as the MUSC and UTHSC Urology residents: Drs. Taylor Vaughan, Samuel Walker 637 
Nickles, Matthew Young, Erin Burns, Justin Ellett, Ryan Levey, Austin Younger, Mark Currin, Nima 638 
Baradaran, Olugbemisola McCoy, Tracy Tipton, Bryce Wyatt, Alyssa Greiman, Sarah Starosta, 639 
Aaron Bloch, Christine Callaway, Lucille Cox, Christian Dewan, Erin Heitman, Bradley Houston, 640 
Stephen Legg, Robert S. Libby, Cole Locklear, Kristen Marley, Monica O’Hanlon, Patrick Probst, 641 
Cynthia Sharadin, Elizabeth Tourville, Daniel Zapata for their help with human tissue collection.  642 
 643 
DISCLOSURES:  644 
None 645 
 646 
REFERENCES:  647 
1 Andersson, K. E., Arner, A. Urinary bladder contraction and relaxation: physiology and 648 
pathophysiology. Physiological Reviews. 84 (3), 935-986 (2004). 649 
2 Brading, A. F., Brain, K. L. Ion channel modulators and urinary tract function. In Urinary 650 
Tract (Editors: Andersson, K.E. & Michel, M.C.), Springer-Verlag Berlin Heidelberg, Germany; Part 651 
of Handbook of Experimental Pharmacology book series. 202, 375-393 (2011). 652 
3 Brading, A. F. Spontaneous activity of lower urinary tract smooth muscles: correlation 653 
between ion channels and tissue function. Journal of Physiology. 570 (Pt 1), 13-22 (2006). 654 
4 Brading, A. F., Heaton, J. P., Hashitani, H. A survey of commonalities relevant to function 655 
and dysfunction in pelvic and sexual organs. International Journal of Impotence Research. 20 (1), 656 
1-16 (2008). 657 
5 Petkov, G. V. Role of potassium ion channels in detrusor smooth muscle function and 658 
dysfunction. Nature Reviews Urology. 9 (1), 30-40 (2012). 659 



   

Page 15 of 20 
 

6 Andersson, K. E. Treatment-resistant detrusor overactivity--underlying pharmacology and 660 
potential mechanisms. International Journal of Clinical Practice Supplement. 151, 8-16 (2006). 661 
7 Sui, G. P., Wu, C., Fry, C. H. The electrophysiological properties of cultured and freshly 662 
isolated detrusor smooth muscle cells. Journal of Urology. 165 (2), 627-632 (2001). 663 
8 Kropp, B. P. et al. Characterization of cultured bladder smooth muscle cells: assessment 664 
of in vitro contractility. Journal of Urology. 162 (5), 1779-1784 (1999). 665 
9 Bonev, A., Isenberg, G. Arginine-vasopressin induces mode-2 gating in L-type Ca2+ 666 
channels (smooth muscle cells of the urinary bladder of the guinea-pig). Pflügers Archive - 667 
European Journal of Physiology. 420 (2), 219-222 (1992). 668 
10 Schneider, P., Hopp, H. H., Isenberg, G. Ca2+ influx through ATP-gated channels increments 669 
[Ca2+]i and inactivates ICa in myocytes from guinea-pig urinary bladder. Journal of Physiology. 440 670 
479-496 (1991). 671 
11 Wellner, M. C., Isenberg, G. Properties of stretch-activated channels in myocytes from the 672 
guinea-pig urinary bladder. Journal of Physiology. 466 213-227 (1993). 673 
12 Wellner, M. C., Isenberg, G. Stretch-activated nonselective cation channels in urinary 674 
bladder myocytes: importance for pacemaker potentials and myogenic response. Experientia 675 
Supplementum. 66 93-99 (1993). 676 
13 Klockner, U., Isenberg, G. Action potentials and net membrane currents of isolated 677 
smooth muscle cells (urinary bladder of the guinea-pig). Pflügers Archive - European Journal of 678 
Physiology. 405 (4), 329-339 (1985). 679 
14 Moore, E. D. et al. Organization of Ca2+ release units in excitable smooth muscle of the 680 
guinea-pig urinary bladder. Biophysical Journal. 87 (3), 1836-1847 (2004). 681 
15 Hristov, K. L., Chen, M., Kellett, W. F., Rovner, E. S., Petkov, G. V. Large conductance 682 
voltage- and Ca2+-activated K+ channels regulate human detrusor smooth muscle function. 683 
American Journal of Physiology - Cell Physiology. 301 (4), C903-912 (2011). 684 
16 Afeli, S. A., Rovner, E. S., Petkov, G. V. SK but not IK channels regulate human detrusor 685 
smooth muscle spontaneous and nerve-evoked contractions. American Journal of Physiology - 686 
Renal Physiology 303 (4), F559-568 (2012). 687 
17 Hristov, K. L. et al. Kv2.1 and electrically silent Kv channel subunits control excitability and 688 
contractility of guinea pig detrusor smooth muscle. American Journal of Physiology - Cell 689 
Physiology. 302 (2), C360-C37 (2012). 690 
18 Afeli, S. A., Malysz, J., Petkov, G. V. Molecular expression and pharmacological evidence 691 
for a functional role of Kv7 channel subtypes in Guinea pig urinary bladder smooth muscle. PLoS 692 
One. 8 (9), e75875 (2013). 693 
19 Smith, A. C. et al. TRPM4 channel: a new player in urinary bladder smooth muscle function 694 
in rats. American Journal of Physiology - Renal Physiology. 304 (7), F918-929 (2013). 695 
20 Smith, A. C. et al. Novel role for the transient potential receptor melastatin 4 channel in 696 
guinea pig detrusor smooth muscle physiology. American Journal of Physiology - Cell Physiology. 697 
304 (5), C467-47 (2013). 698 
21 Hristov, K. L., Smith, A. C., Parajuli, S. P., Malysz, J., Petkov, G. V. Large-conductance 699 
voltage- and Ca2+-activated K+ channel regulation by protein kinase C in guinea pig urinary bladder 700 
smooth muscle. American Journal of Physiology - Cell Physiology. 306 (5), C460-470 (2014). 701 
22 Hristov, K. L. et al. Novel regulatory mechanism in human urinary bladder: central role of 702 
transient receptor potential melastatin 4 channels in detrusor smooth muscle function. American 703 



   

Page 16 of 20 
 

Journal of Physiology - Cell Physiology. 310 (7), C600-611 (2016). 704 
23 Malysz, J., Afeli, S. A., Provence, A., Petkov, G. V. Ethanol-mediated relaxation of guinea 705 
pig urinary bladder smooth muscle: involvement of BK and L-type Ca2+ channels. American 706 
Journal of Physiology - Cell Physiology. 306 (1), C45-58 (2014). 707 
24 Montgomery, B. S., Fry, C. H. The action potential and net membrane currents in isolated 708 
human detrusor smooth muscle cells. Journal of Urology. 147 (1), 176-184 (1992). 709 
25 Parajuli, S. P., Soder, R. P., Hristov, K. L., Petkov, G. V. Pharmacological activation of small 710 
conductance calcium-activated potassium channels with naphtho[1,2-d]thiazol-2-ylamine 711 
decreases guinea pig detrusor smooth muscle excitability and contractility. Journal of 712 
Pharmacology and Experimental Therapeutics. 340 (1), 114-123 (2012). 713 
26 Heppner, T. J., Bonev, A. D., Nelson, M. T. Ca2+-activated K+ channels regulate action 714 
potential repolarization in urinary bladder smooth muscle. American Journal of Physiology - Cell 715 
Physiology. 273 (1 Pt 1), C110-C117 (1997). 716 
27 Petkov, G. V., Nelson, M. T. Differential regulation of Ca2+-activated K+ channels by beta-717 
adrenoceptors in guinea pig urinary bladder smooth muscle. American Journal of Physiology - Cell 718 
Physiology. 288 (6), C1255-C1263 (2005). 719 
28 Herrera, G. M., Etherton, B., Nausch, B., Nelson, M. T. Negative feedback regulation of 720 
nerve-mediated contractions by KCa channels in mouse urinary bladder smooth muscle. American 721 
Journal of Physiology - Regulatory Integrative Comparative Physiology 289 (2), R402-R409 (2005). 722 
29 Malysz, J., Rovner, E. S., Petkov, G. V. Single-channel biophysical and pharmacological 723 
characterizations of native human large-conductance calcium-activated potassium channels in 724 
freshly isolated detrusor smooth muscle cells. Pflügers Archive - European Journal of Physiology. 725 
465 (7), 965-975 (2013). 726 
30 Provence, A., Angoli, D., Petkov, G. V. Kv7 channel pharmacological activation by the novel 727 
activator ML213: role for heteromeric Kv7.4/Kv7.5 channels in guinea pig detrusor smooth 728 
muscle function. Journal of Pharmacology and Experimental Therapeutics 364 (1), 131-144 729 
(2018). 730 
31 Parajuli, S. P. et al. Control of urinary bladder smooth muscle excitability by the TRPM4 731 
channel modulator 9-phenanthrol. Channels (Austin). 7 (6), 537-540 (2013). 732 
32 Ishibashi, H., Moorhouse, A. J., Nabekura, J. Perforated whole-cell patch-clamp technique: 733 
a user’s guide. In Patch Clamp Techniques: From Beginning to Advanced Protocols (Editor: Okada, 734 
Y.), Springer, Tokyo, Japan. 4. 71-83 (2012). 735 
33 Provence, A., Rovner, E. S., Petkov, G. V. Regulation of transient receptor potential 736 
melastatin 4 channel by sarcoplasmic reticulum inositol trisphosphate receptors: Role in human 737 
detrusor smooth muscle function. Channels (Austin). 11 (5), 459-466 (2017). 738 
34 Hristov, K. L. et al. Suppression of human detrusor smooth muscle excitability and 739 
contractility via pharmacological activation of large conductance Ca2+-activated K+ channels. 740 
American Journal of Physiology - Cell Physiology 302 (11), C1632-1641 (2012). 741 
35 Xin, W., Soder, R. P., Cheng, Q., Petkov, G. V. Inhibition of phosphodiesterases relaxes 742 
detrusor smooth muscle via activation of the large conductance voltage- and Ca2+-activated K+ 743 
channel. American Journal of Physiology - Cell Physiology. 302 (9), C1361-1370 (2012). 744 
36 Hristov, K. L. et al. Neurogenic detrusor overactivity is associated with decreased 745 
expression and function of the large conductance voltage- and Ca2+-activated K+ channels. PLoS 746 
One. 8 (7), e68052 (2013). 747 



   

Page 17 of 20 
 

37 Hristov, K. L., Parajuli, S. P., Provence, A., Rovner, E. S., Petkov, G. V. Nongenomic 748 
modulation of the large conductance voltage- and Ca2+-activated K+ channels by estrogen: A novel 749 
regulatory mechanism in human detrusor smooth muscle. Physiological Reports. 5 (14) (2017). 750 
38 Parajuli, S. P. et al. Functional link between muscarinic receptors and large-conductance 751 
Ca2+ -activated K+ channels in freshly isolated human detrusor smooth muscle cells. Pflügers 752 
Archiv - European Journal of Physiology. 467 (4), 665-675 (2015). 753 
39 Malysz, J., Rovner, E. S., Petkov, G. V. Single-channel biophysical and pharmacological 754 
characterizations of native human large-conductance calcium-activated potassium channels in 755 
freshly isolated detrusor smooth muscle cells. Pflügers Archiv - European Journal of Physiology. 756 
465 (7), 965-975 (2013). 757 
40 Thorneloe, K. S., Nelson, M. T. Properties of a tonically active, sodium-permeable current 758 
in mouse urinary bladder smooth muscle. American Journal of Physiology - Cell Physiology. 286 759 
(6), C1246-1257 (2004). 760 
41 Barry, M. J. et al. The American Urological Association symptom index for benign prostatic 761 
hyperplasia. The Measurement Committee of the American Urological Association. Journal of 762 
Urology. 148 (5), 1549-1557; discussion 1564 (1992). 763 
42 Klockner, U., Isenberg, G. Calcium currents of cesium loaded isolated smooth muscle cells 764 
(urinary bladder of the guinea pig). Pflügers Archiv - European Journal of Physiology 405 (4), 340-765 
348 (1985). 766 
43 Klockner, U., Isenberg, G. Tiapamil reduces the calcium inward current of isolated smooth 767 
muscle cells. Dependence on holding potential and pulse frequency. European Journal of 768 
Pharmacology. 127 (3), 165-171 (1986). 769 
44 Weidelt, T., Isenberg, G. Augmentation of SR Ca2+ release by rapamycin and FK506 causes 770 
K+-channel activation and membrane hyperpolarization in bladder smooth muscle. British Journal 771 
of Pharmacology. 129 (7), 1293-1300 (2000). 772 
45 Inoue, R., Brading, A. F. The properties of the ATP-induced depolarization and current in 773 
single cells isolated from the guinea-pig urinary bladder. British Journal of Pharmacology. 100 (3), 774 
619-625 (1990). 775 
46 Inoue, R., Brading, A. F. Human, pig and guinea-pig bladder smooth muscle cells generate 776 
similar inward currents in response to purinoceptor activation. British Journal of Pharmacology. 777 
103 (4), 1840-1841 (1991). 778 
47 Nakayama, S., Brading, A. F. Possible contribution of long open state to noninactivating 779 
Ca2+ current in detrusor cells. American Journal of Physiology - Cell Physiology. 269 (1 Pt 1), C48-780 
54 (1995). 781 
48 Nakayama, S., Brading, A. F. Interaction of Ca2+ agonist and depolarization on Ca2+ channel 782 
current in guinea pig detrusor cells. Journal of General Physiology. 106 (6), 1211-1224 (1995). 783 
49 Gallegos, C. R. & Fry, C. H. Alterations to the electrophysiology of isolated human detrusor 784 
smooth muscle cells in bladder disease. Journal of Urology. 151 (3), 754-758 (1994). 785 
50 JournalFry, C. H., Gallegos, C. R., Montgomery, B. S. The actions of extracellular H+ on the 786 
electrophysiological properties of isolated human detrusor smooth muscle cells. Journal of 787 
Physiology. 480 (Pt 1), 71-80 (1994). 788 
51 Sui, G. P., Wu, C., Fry, C. H. A description of Ca2+ channels in human detrusor smooth 789 
muscle. BJU International Journal. 92 (4), 476-48 (2003). 790 
52 Wu, C., Sui, G., Fry, C. H. The role of the L-type Ca2+ channel in refilling functional 791 



   

Page 18 of 20 
 

intracellular Ca2+ stores in guinea-pig detrusor smooth muscle. Journal of Physiology. 538 (Pt 2), 792 
357-369 (2002). 793 
53 Bonev, A. D., Nelson, M. T. Muscarinic inhibition of ATP-sensitive K+ channels by protein 794 
kinase C in urinary bladder smooth muscle. American Journal of Physiology - Cell Physiology. 265 795 
(6 Pt 1), C1723-1728, doi:10.1152/ajpcell.1993.265.6.C1723, (1993). 796 
54 Bonev, A. D., Nelson, M. T. ATP-sensitive potassium channels in smooth muscle cells from 797 
guinea pig urinary bladder. American Journal of Physiology - Cell Physiology. 264 (5 Pt 1), C1190-798 
1200 (1993). 799 
55 Petkov, G. V., Heppner, T. J., Bonev, A. D., Herrera, G. M., Nelson, M. T. Low levels of KATP 800 
channel activation decrease excitability and contractility of urinary bladder. American Journal of 801 
Physiology - Regulatory Integrative Comparative Physiology 280 (5), R1427-1433 (2001). 802 
56 Shieh, C. C. et al. Functional implication of spare ATP-sensitive K+ channels in bladder 803 
smooth muscle cells. Journal of Pharmacology and Experimental Therapeutics. 296 (3), 669-675 804 
(2001). 805 
57 Shieh, C. C. et al. Characterization of a novel ATP-sensitive K+ channel opener, A-251179, 806 
on urinary bladder relaxation and cystometric parameters. British Journal of Pharmacology. 151 807 
(4), 467-475 (2007). 808 
58 Petkov, G. V. et al. Beta1-subunit of the Ca2+-activated K+ channel regulates contractile 809 
activity of mouse urinary bladder smooth muscle. Journal of Physiology. 537 (Pt 2), 443-452 810 
(2001). 811 
59 Thorneloe, K. S., Nelson, M. T. Properties and molecular basis of the mouse urinary 812 
bladder voltage-gated K+ current. Journal of Physiology. 549 (Pt 1), 65-74 (2003). 813 
60 Hristov, K. L. et al. Stimulation of beta3-adrenoceptors relaxes rat urinary bladder smooth 814 
muscle via activation of the large-conductance Ca2+-activated K+ channels. American Journal of 815 
Physiology - Cell Physiology. 295 (5), C1344-C1353 (2008). 816 
61 Layne, J. J., Nausch, B., Olesen, S. P., Nelson, M. T. BK channel activation by NS11021 817 
decreases excitability and contractility of urinary bladder smooth muscle. American Journal of 818 
Physiology - Regulatory Integrative Comparative Physiology 298 (2), R378-R384 (2010). 819 
62 Lee, H., Koh, B. H., Peri, L. E., Sanders, K. M., Koh, S. D. Functional expression of SK 820 
channels in murine detrusor PDGFRalpha+ cells. Journal of Physiology. 591 (2), 503-513 (2013). 821 
63 Lee, H. et al. Premature contractions of the bladder are suppressed by interactions 822 
between TRPV4 and SK3 channels in murine detrusor PDGFRalpha+ cells. Scientific Reports. 7 (1), 823 
12245 (2017). 824 
64 Yarotskyy, V., Malysz, J., Petkov, G. V. Properties of single channel and whole-cell Cl- 825 
currents in guinea pig detrusor smooth muscle cells. American Journal of Physiology - Cell 826 
Physiology 316 (5), C698-C710 (2019). 827 
65 Driska, S. P., Porter, R. Isolation of smooth muscle cells from swine carotid artery by 828 
digestion with papain. American Journal of Physiology - Cell Physiology. 251 (3 Pt 1), C474-481 829 
(1986). 830 
66 Seltzer, J. L., Welgus, H. G., Jeffrey, J. J., Eisen, A. Z. The function of Ca2+ in the action of 831 
mammalian collagenases. Archives of Biochemistry and Biophysics. 173 (1), 355-361 (1976). 832 
67 Skelton, G. S. Papaya proteinases. I. Temperature-and pH-stability curves. Enzymologia. 833 
35 (5), 270-274 (1968). 834 
68 Petrova, D., Derekova, A., Vlahov, S. Purification and properties of individual collagenases 835 



   

Page 19 of 20 
 

from Streptomyces sp. strain 3B. Folia Microbiologica (Praha). 51 (2), 93-98 (2006). 836 
69 Sharpe, E. J., St Clair, J. R., Proenza, C. Methods for the isolation, culture, and functional 837 
characterization of sinoatrial node myocytes from adult mice. Journal of Visualized Experiments. 838 
(116) (2016). 839 
70 Brueggemann, L. I., Mani, B. K., Haick, J., Byron, K. L. Exploring arterial smooth muscle Kv7 840 
potassium channel function using patch clamp electrophysiology and pressure myography. 841 
Journal of Visualized Experiments. (67), e4263 (2012). 842 
71 Jarriault, D., Grosmaitre, X. Perforated patch-clamp recording of mouse olfactory sensory 843 
neurons in intact neuroepithelium: functional analysis of neurons expressing an identified 844 
odorant receptor. Journal of Visualized Experiments. (101), e52652 (2015). 845 
72 Rae, J., Cooper, K., Gates, P., Watsky, M. Low access resistance perforated patch 846 
recordings using amphotericin B. Journal of Neuroscience Methods. 37 (1), 15-26 (1991). 847 
73 Knutson, K. et al. Whole cell electrophysiology of primary cultured murine 848 
enterochromaffin cells. Journal of Visualized Experiments. (139) (2018). 849 
74 Devienne, G., Le Gac, B., Piquet, J., Cauli, B. Single cell multiplex reverse transcription 850 
polymerase chain reaction after patch-clamp. Journal of Visualized Experiments. (136) (2018). 851 
 852 



Figure 1:

A B C

D E

Figure Click here to access/download;Figure;JOVE Figs-10 Jun 2019_fn.pdf

https://www.editorialmanager.com/jove/download.aspx?id=1059299&guid=33dffb78-6acf-4c0d-aab3-1cb64de31e2b&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1059299&guid=33dffb78-6acf-4c0d-aab3-1cb64de31e2b&scheme=1


50 µm 50 µm

50 µm 50 µm 50 µm

A B C D

50 µm

E

50 µm

F G H

Figure 2:

50 µm



Figure 3:

A B



.......... .
.

..... ......
. ....

A B

C D
.......... .

.

..... ......
. ....

Figure 4:

.......... .
.

..... ......
. ....

....

.......... .
.

..... ......
. ....

....



-10
0 -75 -50 -25 0 25 50 75 10

0

0.0

0.5

1.0

Figure 5:

-10
0 -75 -50 -25 0 25 50 75 10

0
-0.4

0.0

0.4

0.8

-74 mV -74 mV

-94 mV

+96  mV

∆ 10 mV steps

-10
0 -75 -50 -25 0 25 50 75 10

0
-0.5

0.0

0.5

1.0

1.5

2.0

20 pA

100 ms

CU
RR

EN
T 

D
EN

SI
TY

(p
A/

pF
)

200 ms

20 pA
VOLTAGE  (mV)

100 ms

10 pA

A B

C D

-94 mV

+116 mV

CU
RR

EN
T 

D
EN

SI
TY

(p
A/

pF
)

VOLTAGE  (mV)

CU
RR

EN
T 

D
EN

SI
TY

(p
A/

pF
)

VOLTAGE  (mV)



Figure 6:

-10
0 -80 -60 -40 -20 0 20 40 60 80 10

0
12

0
-0.25

0.00

0.25

0.50

0.75

1.00
C

VOLTAGE [mV]
N

O
R

M
AL

IZ
ED

 
D

IF
FE

R
N

C
E 

C
U

R
R

EN
T 

9-PHENANTHROL-SENSITIVE

A

-10
0 -80 -60 -40 -20 0 20 40 60 80 10

0
12

0
-0.25

0.00

0.25

0.50

0.75

1.00

VOLTAGE [mV]

CONTROL 

9-PHENANTHROL (30 µM) 

WASHOUT

N
O

R
M

AL
IZ

ED
  C

U
R

R
EN

T 

* * * * * *

*
*********

B



Species Procedure Details References  

Guinea pig DSM pieces rinsed with Ca2+-free medium (in mM: 100 NaCl, 10 KCl, 1.2 KH2PO4, 5 MgCl2, 20 glucose, 50 taurine, measured pCa=6 (or 1 mM) and then cut into pieces and treated 

typically 90-120 min (4 periods of 30 min) with enzyme medium (in mM: 130 KOH, 20 taurine, 5 pyruvate, 5 creatine, 10 mM HEPES, adjusted with methansulfonic acid to pH 

7.4, 1 mg/ml collagenase, 0.2 mg/ml pronase E, 1 mg/ml fatty acid free albumin, pCa=4.2 (63 mM) or 3.7 (200 mM). Single DSM cells were stored in Kraft-Bruhe (KB)-medium (in 

mM: 85 KCl, 30 K2PO4, 5 MgSO4, 5 Na2ATP, 5 K-pyruvate, 5 creatine, 20 taurine, 5 beta-OH-butyrate, 1 mg/ml fatty acid free albumin, adjusted with KOH to pH 7.2).                                                                                                                                                                                       

Alternative method: DSM pieces rinsed for 10 min in a Ca2+-free medium (in mM): 140 NaCl, 5 KCl, 1.2 MgCl2, 10 glucose, 20 taurine, 5 HEPES, adjusted with NaOH to pH 7.4). 

Then DSM pieces, incubated in the same Ca2+-free medium complemented with 5 mg% collagenase, 2 mg% pronase and 100 μM CaCl2 for 2x20 min stirring.

Klockner & Isenberg (1985)13,34  

Klockner & Isenberg (1986)35           

Schneider et al. (1991)10                 

Bonev & Isenberg (1992)9             

Weidelt & Isenberg (2000)36             

Moore et al. (2004)14

 

Guinea pig, Landrace 

pig, and human 
DSM pieces pre-incubated for 5 min in Ca2+-free Krebs solution then cut into pieces and enzymatically digested in Ca2+-free Krebs solution containing 0.5-2 mg/ml collagenase 

type I and 0.1-0.5 mg/ml pronase at 36°C for 20-30 min constantly stirred. In some cases, digested pieces were further agitated by a blunt tipped pipette or by spinning until 

yielding cells. Isolated cells were stored in modified Krebs solution (described in Klockner & Isenberg13) and were normally used within 3 h. The composition of the Krebs 

solution was (mM): 140 Na+, 6 K+, 2 Ca2+, 1.2 Mg2+, 152.4 Cl- , 10 glucose, 10 HEPES, pH 7.35-7.4 with Tris. For Ca2+-free solution, Ca2+ and Mg2+ were omitted from the Krebs 

solution.

Inoue & Brading (1990)37                   

Inoue & Brading (1991)38            

Nakayama & Brading (1995)39,40

 

Human DSM pieces placed in Ca2+-free HEPES Tyrode’s solution (in mM: 105.4 NaCl, 20.0 or 22.3 NaHCO3, 3.6 KCl, 0.9 MgCl2, 0.4 NaH2PO4 , 19.5 or 4.9 HEPES, 5.4 or 5.5 glucose, 4.5 or 5.5 Na-pyruvate) 

and cut into DSM pieces. DSM pieces soaked in an enzyme solution (Ca2+ free HEPES solution with 0.7 mg/ml collagenase type I, 0.7 mg/ml papain, 1 mg/ml albumin) overnight at 4°C. The strips 

were then heated at 36.5°C for 15 to 30 min, washed and gently triturated in fresh solution. Isolated cells that were stored in Ca2+ containing HEPES Tyrode’s solution or used immediately for 

experiments. 

Montgomery & Fry (1992)24            

Gallegos and Fry (1994)41                     

Fry et al. (1994)
42                                   

Sui et al. (2001)43                                  

Wu et al. (2002)
44

 

Guinea pig DSM cut into pieces in PSS (in mM: 137 NaCl, 5.4 KCl, 2 MgCl2, 2 CaCl2, 0.42 KH2P04, 4.17 NaHCO3, 10 glucose, 10 HEPES, pH 7.4 with NaOH). DSM pieces placed for 10 min in in the following 

digestion solution (in mM: 80 Na-glutamate, 55 NaCl, 6 KCl, 10 HEPES, 11 glucose, 2 MgCl2, and 0.2 CaCl2) and then transferred to a vial containing the same solution but with 1 mg/ml 

collagenase 2, 1 mg/ml trypsin inhibitor (sometimes omitted), 1 mg/ml fat-free bovine albumin, for ~ 70 min at 35°C or ~60 min at 37°C. Single DSM cells were obtained by trituration through a 

Pasteur pipette in the same solution without calcium and enzymes. After trituration, Ca
2+

 (1 mM) was added and the cells were stored at 4°C. The cells were always used on the same day. 

Bonev & Nelson (1993)45,46                                            

Heppner et al. (1997)
26                                       

Petkov et al. (2001)47                                          

Shieh et al. (2001, 2007)
48,49

Guinea pig, mouse, rat, 

and human
Protocol utilizes a two-step enzymatic dissociation treatment following sharp dissection in Ca2+-free digestion solution (in mM: 80 Na-glutamate, 55 NaCl, 6 KCl, 10 HEPES, 11 glucose, and 2 

MgCl2). First, DSM pieces were treated for 25-45 min at 37°C with 1-2 mg/ml papain, 1 mg/ml dithioerythreitol and 1 mg/ml bovine serum albumin in dissociation solution (in mM: 80 

monosodium glutamate, 55 NaCl, 6 KCl, 2 MgCl2, 10 HEPES, and 10 glucose, adjusted to pH 7.3 with NaOH) and then DSM pieces transferred to digestion solution containing 1-5 mg/ml 

collagenase XI (Sigma) or collagenase type 2, 1 mg/ml bovine serum albumin, 0 or 1 mg/ml trypsin inhibitor and 100 μM Ca2+, for 6-30 min. Following incubation, the digested tissue was washed 

several times in digestion solution without enzymes and Ca2+ and then gently triturated to yield single smooth muscle cells. 

Petkov et al. (2001)50                        

Thorneloe & Nelson (2003)51         

Thorneloe & Nelson (2004)
33          

Petkov & Nelson (2005)27                           

Hristov et al. (2008)52                                      

Layne et al. (2010)53                   

Hristov et al. (2011)
15                         

Xin et al. (2012)54                       

Parajuli et al. (2012)25                       

Malysz et al. (2013)29                 

Parajuli et al. (2013)31                               

Lee et al. (2013)55                              

Malysz et al. (2014)23                                

Smith et al. (2013)19,20                                   

Hristov et al. (2016)22                       

Lee et al. (2017)56                               

Yarotskyy et al. (2018)57
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Solution Type Composition (in mM)

DS (Dissection/Digestion Solution) 80 Na-glutamate, 55 NaCl, 6 KCl, 10 HEPES, 2 MgCl2, and 11 glucose, pH adjusted to 7.4 (with 10 M NaOH) 

DS-P  (Papain-containing DS) DS containing 1-2 mg/ml papain, 1 mg/ml dithiothreitol and 1 mg/ml bovine serum albumin 

DS-C (Collagenase-containing DS)
DS solution containing 1-2 mg/ml collagenase type II, 1 mg/ml bovine serum albumin, 0 or 1 mg/ml trypsin 

inhibitor and 100-200 μM Ca
2+

P (Pipette)
110 CsOH, 110 aspartic acid, 10 NaCl, 1 MgCl2, 10 HEPES, 0.05 EGTA, and 30 CsCl,pH adjusted to 7.2 with 

CsOH, and supplemented with amphotericin-B (300-500 μg/ml)

E (Extracellular)
10 tetraethylammonium chloride (TEA), 6 CsCl, 124 NaCl, 1 MgCl2, 2 CaCl2, 10 HEPES, and 10 glucose, pH 

adjusted to 7.3-7.4 with NaOH or CsOH, and 0.002-3  (2-3 mM) nifedipine
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Name Company/Source Catalogue Number Comments

5 ml polystyrene round-

bottom tube
Falcon 352054

Tubes for DS containing 

enzymes used in digestion 

steps

9-Phenanthrol Sigma-Aldrich 211281 TRPM4 channel inhibitor

Amphotericin-B Fisher BP928-250 
Used for patch/cell 

perforation 

Amphotericin-B

European 

Pharmacopoeia 

Reference Standards

5
Used for patch/cell 

perforation

Amphotericin-B Sigma-Aldrich A9528-100MG
Used for patch/cell 

perforation

Analog vortex mixer VWR 58816-121  

Aspartic acid Sigma-Aldrich A9006
Intracellular pipette 

solution

Bovine serum albumin Sigma-Aldrich A7906 DS 

CaCl2 Sigma-Aldrich C1016
Extracellular solution and 

DS 

Capillary Glass Sutter BF150-110-7.5
Capillary for preparation of 

pulled patch electrodes

Cesium hydroxide hydrate Sigma-Aldrich C8518
Intracellular pipette 

solution

Clampex ver. 10 software 

includes data acqusition 

(Clampex) and  analysis 

(Clampfit) programs

Axon Instruments/ 

Molecular Devices
pCLAMP-10

Commerical software and 

part of patch-clamp rig 

setup 

Collagenase type 2
Worthington 

Biochemical Corporation
LS004177 DS-C 

CsCl Sigma-Aldrich 203025
Extracellular and 

intracellular solutions

Dental wax
Miltex Dental Wax 

Technologies, Inc.
18058351

Digital Thermometer with 

Probe
FisherScientific 15-077-32

Placed in tissue bath to 

monitor temperature

Dimethyl sulfoxide  (DMSO) Sigma-Aldrich D2650 Solvent 

DL-Dithiothreitol (DDT) Sigma-Aldrich D9779
Reducing agents used 

together with Papain 

EGTA Sigma-Aldrich E3889
Ca2+ chelator, used in 

intracellular pipette 

solution
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Flaming/Brown micropipette 

puller
Sutter P-97

Required to pull electrodes 

with very fine tips

Floating foam tube 

rack/holder
VWR Scientific 82017-634

Used for holding tubes with 

enzymes for temperature 

control

Glucose Sigma G8270

Glutamic acid (Na salt) Sigma-Aldrich G1626 DS 

HEPES Sigma-Aldrich H3375 pH Buffer

KCl Fisher Scientific BP366-1 Extracellular solution

Low Noise Data Acquisition 

System

Axon Instruments/ 

Molecular Devices
Digidata 1440A

Part of patch-clamp rig 

setup

Magnetic stirrer VWR 01-442-684

MgCl2 (hexahydrate) Sigma-Aldrich M2670
Extracellular and 

intracellular solutions

MicroForge Narishige MF-830
Used for fire-polishing 

electrodes

NaCl Sigma-Aldrich S7653
Extracellular and 

intracellular solutions

NaOH Sigma-Aldrich S8045  

Nifedipine Sigma-Aldrich N7634
L-type voltage-gated Ca2+ 

channel blocker

Nikon inverted microscope, 

TS100 with T1-SM stage with 

5x, 10x, 20x, and 40x 

objectives

Nikon Discontinued
Part of Patch-clamp rig 

setup

Non-metalic syringe needle, 

MicroFil
WPI MF-34G-5

Filling of intracellular 

pipette solution

 Papain
Worthington 

Biochemical Corporation
LS003126 DS-P

Pasteur pipette FisherBrand 13-678-20A

Tips are broken off and fire-

polished and used for 

titration of enzymatically 

treated tissues to release 

single DSM cells from pieces

Patch-clamp amplifier
Axon Instruments/ 

Molecular Devices
Axon Axopatch 200B

Part of patch-clamp rig 

setup

PC computer DELL
Custom 

configuration

Part of patch-clamp rig 

setup

pH Meter Aspera Instruments PH700



Polyethylene tubing Intramedic 427-436

Tubing for superfusion of 

extracellular bath 

connected to glass-bottom 

recording chamber  

Tetraethylammonium 

chloride
Sigma-Aldrich T2265

Ion channel blocker of Kv 

and BK channels added to 

the extracellular bath 

solution

ThermoScientific Precision 

shaking water bath (model 

2870)

ThermoScientific Discontinued

Water bath for temperature 

control of enzymatic 

digestion employed as an 

alternative to tissue 

chamber-circulating bath 

setup 

Tissue bath, 100 mL Radnoti 1583-101

Connected to a circulating 

bath and filled with water, 

tubes with DS and DSM 

pieces are placed in the 

setup to control the 

temperature of digestion 

steps 

Vinyl tubing ColePalmer 06405-3

Multiple uses including for  

connecting tissue  bath to 

circulating water bath 

Water circulator bath, Haake 

D1 L
Haake Discontinued Connected to tissue bath

Weighting scale Mettler Toledo XS64

ZeissAxiovert 40C inverted 

microscope with 10x and 40x 

objectives

Carl-Zeiss Discontinued
Part of patch-clamp rig 

setup
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General Comment: 
We thank for reviewing our manuscript and providing comments for improving presentation of 
our manuscript. Below are our point-by-point responses to each of the comments. 
 
Comments/Points   
 
1: ”Citation?”  
Response: A citation (reference 1) has been added. 
 
2: “Citation?”  
Response:  Citations have been added (references15, 22, 33-39). 
 
3: “This needs clarity.” 
Response: Additional wording “…containing Cs+, TEA+, and nifedipne (please see Table 2)….” Has 
been added. 
 
4:  “What kind of patients are studied in this experiment? Clinical symptoms, age, sex etc?” 
Response: We now specify in the first paragraph of the protocol section that “Patient-donors 

are adult (age range studied until now: 25 to 87 years old), either male or female, with or 

without symptoms of overactive bladder (as classified by American Urological Association I-PSS 

score). Surgical procedures involve a variety of medical conditions including: radical cystectomy 

for urothelial carcinoma, and adenocarcinoma. In such cases, the collected urinary bladder 

specimen is remote from the site of tumor. 

  
5:  “This paragraph has been moved here as we cannot have paragraph of texts in the protocol 
section. If this needs to be a part of the protocol, please make steps and write in imperative 
tense as done for other section.” 
Response: This paragraph has been moved to the Discussion section as the text fits better in this 
section rather than the Introduction.  
 
 
6: “Citation if any?” 
Response: This is an unpublished observation. As such, the text “(unpublished observation)” was 
added at the end of this sentence.  
 
 
7. “Is there a min or max time for keeping the urinary bladder in this solution? “ 
Response: We now clarify that the tissue remained in DS from a few hours to overnight in the 
note after step 1.1.   
 
 

8.  “This needs clarification. Please describe how you get whole thickness DSM specimen from 
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the bladder?”   
Response: We have added the following sentence to the first introductory paragraph. “The 

approved procedures allow whole thickness urinary bladder specimens (>1 cm by >1 cm)  — 

containing all layers including mucosa, detrusor smooth muscle, and serosa as well are attached 

blood vessels and adipose tissue) — to be collected from patients-donors undergoing surgical 

partial extraction of bladder.”  

 

9.  “How would you visually identify this?” 

Response:  Since serosa and mucosa layers are easily visually distinguishable within the urinary 

bladder specimens provided, their identification for removal is usually not an issue. For 

additional clarification, we added ”(containing all layers including mucosa, DSM, and serosa)” 

after “DSM specimen“.   

 

10. “We cannot have commercial terms in the manuscript. Please use generic terms instead. 

Maybe electrical protective coating instead?” 

Response: The term silicone enantiomer has been used instead of Sylgard®.  

 

11. “How to visually identify all these?”  
Response: Since adipose tissue (fat), blood vessels, epithelium (urothelium) and muscularis 

mucosa are easily visually distinguishable within the urinary bladder, the sharp dissection step 

is meant to remove them from the preparation.  

 

12.  “1B and 1C looks essentially the same. Please just show the pieces instead. How do you 
visually identify this be mucosa free?”  
Response:  Fig 1c was redone and now includes an enlarged view of DSM pieces in 1C. In 

addition, labels “ThermoFisher” and “Haake” have been covered. 

 

13. “Please remove or hide the commercial term (Thermo Scientific) from the figure.” 

Response:   Fig.1E was redone without the commercial term “ThermoFisher” visible.  

 

14.  “How many pieces in what volume?”  



Response:   This step is continuation of step 2.1 where the number of DSM strips/pieces (3-6) 

and volume (1-2 mL) are indicated. To avoid confusion these two steps have been now 

combined into a single step (2.1) and other steps re-ordered accordingly. 

 
15. “Do you centrifuge at this stage?”  
Response:   We do not centrifuge. During the enzymatic treatment DSM pieces settle at the 

bottom of the tube so it is easy to remove the supernatant containing enzyme.  

16. “Before this please include a step stating how to check the quality of the preparation. 

Please include the magnification as well.” 

Response: An additional step has been added for visual inspection of the quality of preparation 
(please see step 2.6) that now reads “Place a few drops of DS solution containing dispersed DSM 
cells onto a glass bottom chamber or coverslip and visually inspect for the quality under 
microscope (using a 20x or 40x objective) after at least 5 min following application to allow the 
cells to adhere to the bottom.” 
 

17. “So you don’t count the cell number in this case and just go by volume instead?”  
Response:  Yes, we do not count DSM cells and just use the volume. 
 
18. “Please explain this part… needs more clarity.” 
Response:  We have added the following text after superfusion “ where by gravity the solution 
flow via inlet tubing replaces the extracellular medium of the cells (adhered to the chamber glass 
bottom) while outlet tubing connected to a vacuum waste vessel removes the extracellular 
solution and prevents chamber overflow.” 
 
 
19.  “We cannot have commercial language in the manuscript. Please remove all commercial 
language and refer to the table of materials instead wherever needed.”  
Response: FisherScientific was removed from the text in step 3.3.  
 
20. “Please bring out clarity here as well. What is the pipette solution? Is this solution P from 
the table 2?” 
Response: For clarification, we added the following text to this step “….(solution P, please see 
Table 2)…” 
 
21.  “Please refer the figures in the order of their numbering. Figure 3 will be referred before 
Figure 4” 
Response: Since Figure 3 is now referenced earlier in the note after step 2.7, the figure numbering 
stays at 4 (as in the original submission).   
 

22. “How do you apply the same?”  



Response: We now clarify that the negative pressure is applied rapidly to the electrode holder 
via tuning. This results in negative pressure created at the tip of the electrode which pulls cell 
membrane into electrode forming a giga-seal or very tight connection between electrode 
opening and plasma membrane. We do not quantify the level of pressure. 
 

23. “How do you monitor the giga-seal stability?”  
Response:  We now explain that giga-seal stability is monitored with the commercial acquisition 
software  (Clampex) utilizing the Membrane Test function/window (please see step 3.12 in 
revision). 
 
24.  “Do you use this software and these clicks to test the stability? If yes, then please make 
this a part of the step and not a note.” 
 
Response:  We have modified steps 3.9 and 10 in response to this comment to highlight 
functionality of the Membrane Test function that is used to determine electrode resistance, giga-
seal stability, and level of cell perforation with amphotericin-B. The text in the steps now read as 
follows:  
 
“3.9  Using a micromanipulator, place the electrode just below the surface of the extracellular 
solution so that the tip of the electrode is just submerged.   
 
3.10  In the voltage-clamp mode, set the holding potential to 0 mV and adjust the current to 0 
pA with the pipette offset dial on the commercial amplifier (please see Table 3, Materials and 
Chemicals). 
 
3.11  Determine the electrode resistance using the Membrane Test window/function of the 
commercial acquisition software (please see Table 3, Chemicals and Materials). To activate click: 
Tools>Membrane Test>Play or a shortcut icon in the software. The determined electrode 
resistance should be in the range of 2 to 5 MΩ.  

 
NOTE: Membrane Test function provided in the commercial acquisition software or Seal Test 
option on the amplifier can be used to monitor electrode resistance by applying voltage steps 
repetitively.” 
 
3.12  Continue monitoring electrode resistance while advancing the electrode toward a chosen 
DSM cell with a micromanipulator (see Figure 4A).”  
 
 
25.  ”How do you do so?  
Maybe reword the sentence:  In the commercial software (see table of materials) click 
tools>Membrane Test and then xxx to see the increase in the cell perforation…as observed by 
….. in the screen 
In the table of materials include a comment data acquisition software for this one.”  

Commented [A1]: Please refer the figures in the order of 
their numbering. Figure 3 will be referred before Figure 4.  



 

Response:  We have modified the text for this specific point by combining relevant steps. The 

new step (3.13 in revision) now contains the following for improved clarity:  

3.15  Allow time, typically 30-60 min, for amphotericin-B to diffuse down the pipette and be 
inserted into the plasma membrane forming pores primarily selective to monovalent cations. 
During this step, continue monitoring the giga-seal with the Membrane Test function. As cell 
perforation increases so does the amplitude of the capacitance transients (compare Figure 4B 
versus Figure 4C displaying no and effective cell perforation, respectively) measured with the 
Membrane Test function.”   
 

26. “How?” 

Response: We now explain that the test condition solution changes are done by superfusion.  

 

27.  “These are the actual actions, please make these as numbered substeps (3.13.1… )and 
highlight these as well.” 
 

Response:  This section has been expanded and includes substeps  (3.15.1 – 3.15.2).  

 
28. “Please move these details to the table of materials.”  
Response: The details have been removed from the Protocol section and referenced in Table 3.  
 

29. “Added to bring out clarity. Please check. “ 
Response: We have check this and agree. 

 

30. “Please move this to the table of materials and use generic term instead.” 

Response:  We have replaced “Clampfit” with “the commercial analysis software (see Table 3,  

Materials and Chemicals). 

 
31. “Reworded for clarity please check.” 
 Response: We have check this and agree. 

 

32.  “Analysis software?” 



Response: We have replaced “Clampfit” with “the commercial analysis software (see Table 3,  

Materials and Chemicals). 

 

33.  “How?” 

Response”: We now include the formula for normalization calculation as 

“Response/ResponseControl-Max”. 
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